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Технические требования к макетам в электронном виде

(офсетная печать)

Носители

Электронные оригинал-макеты предоставляются на следующих носителях:
   - DVD-ROM

   - CD-ROM

   - CD-RW

   - USB Flash Drive

Возможен прием работ через E-mail или FTP по согласованию с отделом дизайна. 
Названия файлов

Все файлы, относящиеся к одной работе, должны находиться в одной папке.
Папки не должны иметь русских имен и иметь длину более 8 символов. 
Название файла не должно превышать 10 знаков.
В именах файлов допускается использование только латинских букв a-z, A-Z и цифр 0-9.
Для разделения слов и знаков допускается использование нижнего подчеркивания “_”.
Для удобства в работе рекомендуем, чтобы название файла соответствовало его
содержанию, например: cover.pdf (обложка), block. pdf (блок). 
Не допускается использование одинаковых имен для разных файлов, относящихся к одной
публикации.

Форматы файлов
Макеты принимаются в следующих форматах:
I. Полностью готовые к печати файлы, не требующие конвертации:
1) .AI (Adobe Illustrator, версия не выше CS6, PostScript Level 2);

2) .EPS (сохраненный из Adobe Illustrator, из Adobe Photoshop или экспортированный из CorelDraw, версия не выше CS6, PostScript Level 2);

3) PDF;
4) TIFF (разрешение изображения 300 dpi, без слоев, альфа-каналов и компрессии);
5) PSD* (Adobe PhotoShop, разрешение изображения 300 dpi, без слоев, альфа-каналов и компрессии);
II. Файлы верстки**, требующие конвертации в формат файла вывода*:
1) Adobe Indesign (версия не выше CS6);

2) QuarkXpress (версия до 3.3x-6.x);

*Конвертация файлов верстки в формат файла вывода(см. п. I) является платной услугой.
** Файлы верстки принимаются только при наличии всех файлов шрифтов и иллюстраций (лучше всего для этого использовать команду File (Файл) / CollectForOutput / Package(упаковать)). 

Внимание! Файлы 
· MS Office (Word, Excel, PowerPoint, Publish) 

· .DVG (AutoCad)
не считаются печатными и в работу НЕ принимаются.
Распечатка оригинал макета
Наличие подписанных заказчиком распечаток оригинал макета с пронумерованными страницами — обязательно.

Распечатка должна полностью соответствовать электронному оригинал-макету на носителе.

Все элементы изображения должны читаться. 

Распечатка не должна содержать редакторской и корректорской правки. 

Все страницы должны быть подписаны в печать ответственным лицом заказчика или им самим.

В бумажной распечатке должны быть указаны все номера страниц и отмечены все пустые полосы. Если на полосе отсутствует колонцифра, на распечатке номер полосы указывается вручную.

Для обложек под КБС и термонить предоставляется бумажный макет с вычерченным корешком. 

На макете должно быть указано точное месторасположение вклеек и вкладок в издание, а так же указан их формат.

На распечатках должны обязательно присутствовать обрезные метки.

Если на публикации имеются дополнительные элементы (перфорация, биговка, фальцовка...), должно быть указано их точное размещение на макете. 

1) Распечатки полос, которые содержат более или менее 4-х красок, должны иметь четкую информацию о том, какие именно краски используются для печати данной полосы.

Требования к формату публикации

· Для файлов, сделанных в программах верстки и программах векторной графики, размер документа должен точно соответствовать обрезному формату издания, причем припуск на обрез с внешней стороны (все плашки, фон, заливка и т.д.) от обрезного формата должен быть по 5 миллиметров с каждой стороны (слева, справа, сверху, снизу). Например, буклет форматом А4 имеет размер 297х210, а значит, фон изображения должен быть 307х220.

· Для файлов, сделанных в Photoshop, размер должен быть точно равен обрезному формату плюс 5 мм с каждой стороны.

· Евробуклет (А4 с двумя фальцами) верстается разворотами в дообрезном формате. Стандартное соотношение полос готового изделия формата А4 равно 98х99х100 мм – лицо, 100х99х98 мм – оборот.

· Вырубные макеты верстаются в довырубном формате (с равномерными вылетами с каждой стороны, не менее 3 мм). В верстке обязательно должен присутствовать наложенныей сверху контур штампа. Макет штампа прорисовывается векторными линиями (вырубные ножи сплошными линиями, а биговальные ножи пунктиром), и окрашиваются в отдельный спотовый цвет под названием «Stamp», с обязательным присвоением значения overprint. Минимально допустимое расстояние между параллельными ножами 10 мм. Минимальный радиус скругления углов 5 мм.

· Любые ключевые позиции (текст, логотипы, мелкие элементы и т.п.) должны располагаться на расстоянии не менее 5 мм от обрезного края!

Шрифты
· Все шрифты в макете должны быть переведены в кривые ;

· В случае передачи в типографию файлов верстки (Adobe Indesign, QuarkXpress) к макету должны прилагаться файлы шрифтов.
Минимальный размер шрифта:
Для рубленных гарнитур — 6 pt (CMYK), 4 pt (монохромный цвет)

Для засеченных гарнитур — 7 pt (CMYK), 5 pt (монохромный цвет)

Выворотка для рубленых гарнитур — 8 pt (CMYK), 6 pt (монохромный цвет) 

· Выворотка для засеченных гарнитур — 9 pt (CMYK), 8 pt (монохромный цвет)

Состав чёрного цвета для шрифтов должен быть C=0, M=0, Y=0, K=100 !

Требования к цветам, используемым в публикации

Определение цвета может производиться только по каталогам стандартных цветов. 

Для определения триадных “Process” цветов должны использоваться каталоги “PANTONE Process”, смесевых — “PANTONE Formula Guide”, соответствующие типу бумаги. 

Черный текст — 0/0/0/100, атрибут — “overprint”, для черных плашек большей площади — 40/30/30/100.

По умолчанию “Spot”-цвета выводятся с углом наклона “Black”. Если вы используете 2 и более “Spot”-цветов, углы наклона растра должны быть отличны друг от друга

Все одинаковые “Spot”-цвета, используемые в разных иллюстрациях одного издания должны иметь одинаковое наименование.

При создании цветов во всех программах необходимо учитывать, что допуски при производстве диапозитивов составляют 1,5 - 2% и при производстве печатных форм 2 - 3%, то есть 3 - 4% плашка может быть потеряна. 

Отслеживайте суммарную плотность красок (C+M+Y+K). Допустимые значения для мелованной бумаги - 300, для немелованной - 240.

Для корректной цветопередачи рекомендуем применять следующие параметры цветоделения:

Ink Colors — Eurostandart (Coated)

Dot Gain — 18% (офсет) 13% (мелованные бумаги)

Separation Type – GСR (Gray Color Replacement)

Black Generation — Light

Black Ink limit — 85%

Total Ink limit — 300%

Все цвета неиспользуемые в публикации должны быть удалены.
Особенности работы с пантонами:

1. Даже если Adobe Illustrator показывает на экране overprint preview, тем не менее нужно обязательно проверять сепарированный вариант, т.к. частая ошибка – наличие CMYK цветов в макете, которые не так просто заметить. 

2. Нельзя применить overprint к объектам одного цвета. 

3. Черная и металлизированная краски придадут вашей работе роскошный вид, но они являются кроющими, и при встрече их друг с другом иногда необходимо отказаться от overprint и выполнить для них треппинг. 

4. Пользуйтесь веером (color formula guide) для выбора цвета, т.к. монитор некорректно отображает большую часть цветов из библиотеки пантон. 

5. Печать пантонными цветами дороже, чем печать триадными красками. 

6. Конечный результат не напечатать на принтере, не сделать в цветопробу, сложно увидеть на мониторе.

7. Перед тем как начать делать свой шедевр, создайте сразу набор цветов (spot), т.к. потом придется очень долго отлавливать CMYK в огромном количестве слоев, градиентов и паттернов.

8. Тонкие линии сделанные процентом от пантона выводятся растровой точкой. Поэтому если Вам нужна «светлая» линия – задавайте её размер не менее 0,5 pt, а если нужна очень тонкая линия – 0,1-0,5 pt,  то задавайте её цвет только 100%  пантона.

Требования к растровым иллюстрациям и публикациям

Все растровые изображения должны быть предоставлены в следующих цветовых моделях: 

CMYK, Grayscale, Bitmap
Все растровые изображения должны быть предоставлены в следующих форматах:

TIFF (без LZW— компрессии!!!)

EPS (без JPEG-компрессии, Halftone Screen, Transfer Function, PostScript Color Management)

Достаточное разрешение для макета, изготовленного в Photoshop, является 300 dpi.

Для штриховых изображений разрешение 600-1200 dpi. 

Использование растровых изображений в программах верстки в масштабе менее 90% и более 110% не допускается.

Убедитесь, что файл не содержит в себе никаких дополнительных каналов  - Channels (кроме Multichannels), слоев - Layers и путей - Paths, за исключением пути обтравки Clipping Path (поле Flatness необходимо оставить пустым).

Duotone сохраняйте только как Multichannel файлы и сохраняйте как:  

Photoshop DCS 2.0 (*.EPS)

-Preview: TIFF (8 bit/pixel)

-DCS: Single или Multiple File DCS, No Composite
-Encoding: Binary
-Без Halftone Screen и Transfer Function
Недопустимо использование форматов *.JPG, *.GIF, *.BMP, *.PICT. Такие файлы, а так же файлы формата *.doc, *.xls ... не принимаются в качестве оригинал макетов. Такие файлы принимаются лишь в качестве исходных рабочих материалов.

Файлы формата TIFF не должны содержать слоев!

Файлы и слои в среде программы называйте латинскими буквами (избегайте русской раскладки при сохранении файла)

Требования к векторным иллюстрациям и работам

Adobe Illustrator

Для дальнейшего использования в программах верстки, допускается создание векторных изображений только в формате *.EPS версия не выше 9.0. 

При сохранении *.EPS-файла переведите все шрифты в кривые. 

Обязательно проверьте текст на дробление букв. 
Сохраняйте только используемые при печати элементы в публикации, при этом помните, что количество узлов в кривой не должно превышать 800. Наличие в файле невидимого некорректного объекта, может привести к сбою программного обеспечения фотонабора или CTP. 

В CMYK-файл помещайте растровые изображения, переведенные в формат “CMYK”! 

Экспорт файлов “CorelDraw” (в формате *.EPS) в другие программы может привести к непредсказуемым результатам. После такой операции файл необходимо открыть и редактировать в пакетах предназначенных для работы с векторной или растровой графикой (Adobe Illustrator, Adobe Photoshop), с последующим пересохранением в версии программы редактора.

В диалоговом окне “swatches” должны оставаться только те цвета, которые будут использоваться при печати, нельзя задавать “Spot”-цвета для дальнейшей печати CMYK, т.к. при совпадении названий “Spot”-цветов в разных файлах выводится единый цвет.

Векторные и растровые изображения настоятельно рекомендуется вставлять в программу верстки (QuarkXpress,  AdobeInDesign) раздельно.

Нежелательно в векторные файлы втягивать растровую графику, необходима  “сборка” макета в программе верстки (QuarkXpress,  AdobeInDesign). 

При создании самостоятельных публикаций в Adobe Illustrator 

Кроме файла документа Adobe Illustrator необходимо подавать все заверстанные изображения (Linked Images) и все использованные шрифты.

Прежде чем применять в 9 - 10-м Illustrator’е эффекты, связанные с прозрачностью, необходимо тщательно ознакомиться с разделами «Trabsparency support» и «Flattering guide». Если для реализации вашего дизайна прозрачность все же необходима, то перед сохранением финальной версии файла необходимо осуществить Rasterize - растрирование всех эффектов в единый объект и проанализировать результат на экране или распечатке - так будет и на пленках.Переведите элементы изображения на один слой. 

Если вы сдаёте листовку готовую (на вывод) мы рекомендуем включать изображения в состав публикации. Если файлы требует доработки или цветокррекции, то используемые картинки должны быть приложены в том виде, который используется в файле.

Шрифты перевести в кривые: Type -> Create Outlines. 

Во избежание появления ломаных линий и рваных краев не устанавливайте параметр”Output” в палитре “Attributes” ниже 2400 dpi. при сохранении сложной графики активируйте кнопку “Split long path”. По умолчанию “Spot”-цвета выводятся с углом наклона “Black”. 

По умолчанию “Spot”-цвета выводятся с углом наклона “Black”.

При создании нового документа в поле “File -> Document Setup -> Output resolution” поставьте разрешение выводного устройства. 

Удалите неиспользуемые “Brushes” и “Swatches”.

Верстайте в обрезной формат!

Треппинг и Оверпринт
Качественный треппинг многих работ — это необходимость, так как не существует идеальных печатных машин и идеальной бумаги. Выворотка размером меньше 8 пунктов на многоцветном фоне зальется краской независимо от талантов печатника и стоимости оборудования, а на границах темных цветов может просвечивать белая бумага. Во избежание подобных проблем большинство верстальных и иллюстративных программ обеспечивают автоматический треппинг. Не пренебребрегайте их возможностями! А при наличии вывороток позаботьтесь о них отдельно и сделайте его в ручную.
Если на вашем изображении присутствуют большие области со сплошной черной заливкой, для достижения более глубокого черного цвета рекомендуется пользоваться цветом состава [40-30-30-100]. Во всех остальных случаях состав черного цвета должен быть [K100] — это особенно касается черных участков в растровых изображениях с текстом поверх них. Альтернативный способ — подложить под такой текст его копию и дать ей обводку [K100] в режиме «knock-out».

В некоторых случаях мы можем запретить объекту создание вырубки под собой. Для этого и служит специальный атрибут – оverprint. Объект, имеющий атрибут overprint, не делает под собой вырубки в тех цветах, которых он не содержит. Вследствие чего совмещать объект и вырубку не придется. Нет «дырки» – нет проблем с совмещением. Если желтый объект лежит поверх голубого фона, и без вырубки в голубом, то в наложении будет сумма двух цветов, объект станет зеленым. Еще хуже, когда фоном идет пестрая картинка (растровая или векторная – не важно). 

Если сделать overprint белому объекту - он просто исчезнет при выводе на пленки, но может присутствовать на распечатке. Поэтому обычно объекты в издательских программах идут с атрибутом knockout (делают вырубки).

В каких случаях overprint нужен.  Когда цветовые сдвиги не опасны и незаметны. К примеру, если объект черный и мелкий. Если черный текст восьмого кегля идет поверх голубого фона с атрибутом overprint, то цветовой сдвиг в наложении K+C не существенен. Сдвиг есть (текст немного потемнеет), но он практически незаметен. Но если мы забудем про overprint, любой глаз заметит малейшее не совмещение между текстом и вырубкой под него в голубом. Если говорить в общем, то суть выбора проста: нужно решить – что заметнее, дефекты не совмещения или цветовые сдвиги и «просвечивание». Для черного заметность misregistration на порядок выше, чем сдвиги. Поэтому предоставляя нам макет обязательно пускать черный в наложение – all black overprint, причем в файлах *.EPS и *.AI параметр overprint устанавливается в ручную.

Офсетный черный – краска хоть и темная, но не абсолютно черная. И при этом достаточно прозрачная. Если вы сделаете overprint черной плашке размером 5x5 см и идущей поверх картинки, то картинка будет проглядывать под черным. Если ваша линия имеет толщину 5 мм, не стоит ей делать overprint, т.к. объекты, лежащие под ней, будут легко читаться глазом. Аналогично и с текстом большого кегля.
Ответственность за исполнение режимов Overprint/Knockout полностью возлагается на Заказчика!!!
Ни одна автоматическая функция и специалист препресса не в состоянии распознать вашего художественного замысла. Осуществляйте Overprint/Knockout объектов в тех приложениях, в которых они были созданы. Обратите особое внимание на взаимоотношения черной и металлизированных красок. Не переоценивайте их кроющиеся свойства. Не используйте атрибутов Overprint, если только это не задумано специально.

QuarkXpress, Adobe InDesign
Если вы верстаете в QuarkXpress 4-ой версии, проверьте, чтобы он был обновлен, по крайней мере, до версии 4.04. Верстка не должна содержать нестандартных расширений “Extentions”. В папке “Collect” не должно быть лишних изображений, не используемых в публикации, в том числе и промежуточных рабочих файлов. 

Файл на вывод должен собираться командой QuarkXpress - Collect for Output, Adobe InDesigh – Package. После сборки (“collect”) публикации, нельзя вносить изменения ни в публикацию, ни в файлы поддержки. 

Сделав следующую операцию: “File -> Save as/export -> Page as EPS...” и вставив полученный файл в какой-либо (в том числе “QuarkXpress”) пакет верстки, вы берете всю полноту ответственности на себя.
На вывод кроме файла документа необходимо предоставлять все заверстанные в полосы изображения и шрифты. 

Все цветные растровые изображения должны быть в цветовом режиме “CMYK”, векторные файлы должны иметь формат “*.EPS”. 

При втягивании EPS-файлов в программы верстки, они не должны содержать шрифтов и растровых вставок. 

Растровые изображения вставляются отдельно и не должны иметь лишних (неиспользуемых) каналов и путей. 

При верстке иллюстраций в рамках необходимо, чтобы откадрированное изображение имело запас не менее 1 pt (0,3 мм) со всех сторон.

Во избежание появления муара и зубчатости все изображения должны быть заверстаны в 100%-м масштабе.

В верстке должны присутствовать только те цвета, которые используются при печати, все остальные должны быть удалены. 

В самой верстке, нельзя оставлять какие либо объекты за пределами полос на монтажном столе.

Мы рекомендуем проверить и «собрать» его с помощью программы FligthCheck.

В диалоговом окне “Edit Colors” должны оставаться только те цвета, которые будут использоваться при печати. 

По умолчанию “Spot”-цвета выводятся с углом наклона “Black”. Если вы используете 2 и более “Spot”-цветов, углы наклона растра должны быть отличны друг от друга.

Правильно устанавливайте параметры “Trapping”, при использовании эффектов “Outline” и “Shadow” в тексте. 

Старайтесь не поворачивать, а так же не уменьшать (увеличивать) графические файлы в программах верстки. 

Не помещайте элементы в верстку через “Clipboard” и средствами “OLE”. 

Не используйте для текста “All Caps” и “Small Caps”. 

Не используйте “Non-White Areas” в “Items -> Modify -> Clipping -> Type”. 

Обращайте внимание на количество узлов (Points) в графических файлах с использованием “Embeded Path”, оно не должно превышать 800 узлов в одном объекте. 

При использовании нестандартных “Extentions” необходимо предупредить об этом и передать эти расширения вместе с файлами верстки. 

При использовании в публикации “нестандартных” параметров треппинга, обязательно укажите это в технической карте заказа! 

PDF

В работу принимаются только композитные PDF-файлы,
желательно соответствие стандарту PDF/X-1a; PDF/X-3.
Цветовая модель: Composite CMYK или Grayscale

Размер PDF файла должен ровняться дообрезному формату изделия.

Файл не должен содержать меток реза, фальца, бига и любой другой технической информации, но в сопроводительных документах обязательно указываются точный дообрезной и точный обрезной форматы изделия, координаты фальца и бига.

Многостраничные документы должны быть конвертированы в один постраничный PDF-файл (не разворотами), с равномерными вылетами с каждой стороны (не менее 5 мм.). Все значимые элементы, находящиеся внутри страницы, должны располагаться на расстоянии не менее 5 мм от обрезного формата. При наличии рамок на полосах – расстояние не менее 10 мм от обрезного формата.

Для продукции, скрепляемой клеевым бесшвейным способом, необходимо учесть влияние корешка на текст и изображения, проходящие через разворот. Роспуск должен составлять не менее 4 + 4 мм. Кроме того, в изданиях скрепленных клеевым способом необходимо учесть то, что боковая проклейка корешка уменьшает полезную площадь внутренних полос обложки, первой и последней страницы блока примерно на 5 мм со стороны корешка.

Требования к цветопробе
Для контроля качества цветоделения и в качестве эталона цвета для печатника, может использоваться только цветопроба (аналоговая при использовании форм способом копирования или цифровая при использовании форм изготовленных по технологии CtP).

Оттиски с принтера или цифровой машины эталоном цвета служить не могут! 

Цветопроба должна быть изготовлена на оборудовании, калиброванном в соответствии с печатным процессом и с тем же порядком наложения красок: (BlacK, Cyan, Magenta, Yellow).

При сравнении печатных оттисков с цветопробой следует учитывать следующие факторы:

Цветопроба не учитывает влияние бумаги на печатный оттиск;

Не все оттенки цифровой пробы идентичны печатным оттискам;

Оттенки цвета на аналоговой цветопробе всегда насыщеннее чем на печатных оттисках;

Цвета-spot, на цветопробе не отражаются, их можно их передать близким составом CMYK, но нужно помнить, что многие цвета Пантона не возможно повторить в CMYK;

Цветопроба не может абсолютно точно моделировать печатный процесс.

Часто встречающиеся ошибки,  обратите внимание и не повторяйте их сами:

· Предоставление макета без распечатки.

· Распечатка не соответствует электронной версии макета.

· Наличие  непереведенных в кривые шрифтов в eps-файлов

· Отсутствие изображений в макете (часто из-за длинных имен, названий по-русски).

· Изображения в цветовом режиме RGB.

· Неправильное разрешение растровых изображений (слишком маленькое/большое).

· Размер страницы не соответствует обрезному формату изделия, позиционирование не по центру.     

· Отсутствуют вылеты под обрез, метки фальца и биговки.

· Использование эффектов прозрачности в Adobe Illustrator.

· Не правильно или некорректно заданы Spot-цвета.
· Отсутствует overprint на черном цвете.

· Суммарную плотность красок (C+M+Y+K) выше 300 для мелованной и выше 240 для немелованной бумаги.

Настоятельно рекомендуем перед сдачей материала в типографию проводить проверку программой FlightCheck, на многие возможные проблемы она укажет и создаст полноценный “Collect” со всеми используемыми изображениями и шрифтами.

По всем вопросам, возникшим в процессе подготовки макета к сдаче в типографию, обращайтесь к нашим специалистам.
Что проверяется в типографии при приеме файлов 

В типографии перед выводом издания на печатные формы электронный оригинал-макет, представленный в выше перечисленных программах проверяется на:

• соответствие типов файлов издания типам, указанным в технических требованиях,

• соответствие обрезного формата электронного оригинал-макета формату заявленному выше,

• наличие вылетов за обрезной формат не менее 5 мм,

• наличие иллюстраций, выполненных в цветовых моделях, отличных от CMYK, Grayscale, Bitmap

• наличие иллюстраций с низким разрешением (менее 250 dpi для линиатуры 150 lpi и менее 300 dpi для линиатуры 175 lpi).

Электронный оригинал-макет, представленный в виде PDF проверяется на:

• соответствие обрезного формата электронного оригинал-макета формату заявленному выше,

• наличие вылетов за обрезной формат не менее 5 мм,

• наличие всех шрифтовых начертаний,

• наличие иллюстраций, выполненных в цветовой модели RGB.

В случае обнаружения ошибок при проверке указанных выше параметров электронный оригинал-макет будет возвращен на доработку заказчику или направлен на доработку в отдел допечатной подготовки, что в обоих случаях может привести к смещению сроков сдачи тиража заказчику. 
Если в процессе изготовления макетов у Вас возникли какие-либо вопросы, пожалуйста, проконсультируйтесь с нашими дизайнерами по телефону (495) 645-66-88.
В случае несоответствия электронного оригинал макета техническим требованиям типографии ответственность за качество печати тиража лежит на Заказчике.
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